IntelliForms

QuickStart Guide

2009



Table of Contents

110 o LU o3 1 o PSPPI 4
l. Getting Started — First TIMe USE ... 5
A. AcCeSS and AULNOTZALION .........cciiiiiieiii e 5
B. DISPIAY SEIINGS .. .cviiiiitiiiieteiee bbbt b bbbt 6
C. Select State JUMNSAICTIONS.......ccoiiiiieiiie et 7
D. Setting PreferENCES ....c.vcie et et 7
SIBCT FOIMIS ...t b e bbbttt e 8
INPUE FIEIAS ...ttt be e nbe e nrean 9

4 o101 0 PO T PR TRTPPPPPROUPRP 9

F (1Y = T g T = SRR 9
CHENT FOIMS ...ttt et e st e s be e eeareenteenseaseenreaneenreas 10
INTEINEL PrefErENCES ...ttt bt n e sae e 10
F. SEHING UP PrINIEIS ..ottt be et reeee e e nne e 10
G. Customizing your Back-Up SChEME .........ccccveiiiie e 11
H. AAMINIStration and SECUILY .........ccuiiiiiiiieiice e e 12
Il. The IntelliForms Workspace — the Manager VIeWs .........cccccevvvieeiiieveiiiiiiiiee e, 13
A. Using the Find Box and Filters in the Manager VIEWS ..........cccccvvevivereiieseese e, 14
B. Sorting in the Manager VIEWS ..ot sae et 15
C. Blank FOIMmMS MEaNAGET ........oiiiiiieieies et 15
FINAING FOIMIS ...t ettt ettt esbe e be e e nreas 16
Multiple Searches and FOrm SelecCtionS..........c.cccvevviiiicie i 17
Opening Blank FOIMS........cuviiiice et ne e 18
Opening Forms already saved for CHENtS...........ccovieiiiieiece e 19
Opening Non-Reproducible FOrMS........ccccciiieiiic e 19
Opening FOrmM INSTIUCLIONS ......cccooiuiiiiieee et ra e enes 19
Opening Prior Year FOrms & PUDIICALIONS ..o 20
UPAAiING FOIMIS ...t ettt et sbe et e ne e b e beeneenneas 20
D. Client FOrMS MANAGET .......ccveiuieiectie ittt ta e raesre s e s beestesreesreeneaneenneens 20
(@] 01T o T To T O 1T=T 0] A o] 1 14 1 TSP 22
Opening Forms for Multiple Clients and/or Multiple Years.........cccocivinieniiiniieiene 22
Marking Completed CHENTS ..o 23
Customizing the Client FOrMS Grid ..........cccoiiieiiiieiicce e 23
Transferring CHENt FOIMS ... 24
Backing- UpP CHENt FOIMIS ......oouiiiiiei ettt 25
RESLOrNG ClENT FOIMMIS.....cuiiiice ettt ettt e re e te e sreas 25
I e (0] 1] (ST 1V F= T = Vo 1= PSS 25
PrOTIE Ty PES. e ettt nre s 26
Creating& Editing Profile@S ..o 26



IMPOITING PrOfIIES ... 28

Transferring Profile DAta...........cccoiiiiiieiiie e 29
APPIYING Profiles t0 FOIMS.........oi et 30
F. ClIent VIEW MaNAJET .......cciiiiiiieie ettt te et ste s e staesaeaneestaenaeaneenneens 30
The CHENE FOIM SEL.......ooiiiie ettt nne e 30
How Data Transfers in the CHENt VIEW ... 31
Navigation iN the CHENE VIEW.........ccviiii et 31
DAta ENTIY ... 33
Adding FOrms t0 @ SAved ClIENT ..o e 35
Working with the CHent FOImM Set........cccoov i 35
Y= 1Y/ o @A 1= | o T PSS 36
Saving Client FOrms as PDF FIlES ..o e 37
Updating Saved Clent FOMMIS ..ottt sre s 37
L PIINTING i 38
A. Printing BIank FOIMIS.......cooiiiiiiic et ste e nne e 38
B. Printing CHENT FOIMMS ....cuoiiiiie bbb 39
Printing SPecific CHENt FOIMS .......ocoii e 39
Printing the CUITENt PAQE .......coviiieiece ettt nne s 40
C. Printing Information Reporting FOIMS..........ccooiiiiiiie e 40
D. Closing the Print MANAQET ...........oiiiiiiieiieiieie et sae e 41
E. Change Printer and Print Properti€s .........ccccve it 41
V. Getting HEIP ..o 42
A. ACCESSING RESEAITK ...t ae e nre e 42
B. HEIP MOAUIES ...ttt 42
STU] o] o [0 A =bq o] (o] £ = SH SRR 42
Program HEIP ... ..cooiiee ettt et e et et e e e re e nres 43

(@ 10 1o 1 IV (o] £SO PTSTRPT 43

(@ 10 [od 6] =1 A 101U | OSSP PR TSP 43
O @ o] [T T= IS ] o] o L] o (OSSR SRR 44
D. Product INTOrME@LION........cviiiiiiiie ettt 44



INTRODUCTION

Welcome to the world of IntelliForms™, the most current, comprehensive and easy-
to-use solution for interactive forms available to tax professionals today.

IntelliForms is CCH’s new interactive forms product. It provides the forms you need,
when and where you need them. Similar to CCH's perform plus Il and ATX's
ZillionForms, IntelliForms is a desk top application that contains tens of thousands of
interactive forms.

The following are just a few of the features of IntelliForms.

Intuitive and easy to use: IntelliForms is easy to learn and use with its
simple, interface. IntelliForms always opens to the Blank Forms manager
where you may open a blank form, add a new form for a client, print a blank
form, or open the instructions to a form.

Easy form searching: Use either (or both) Filters and Find to locate the form
you need in the Blank Forms manager. The search begins to work as soon
as you start typing.

Tabs for easy organization of forms: IntelliForms provides several different
tabs to organize your forms. The Blank Forms manager lists all the forms
available in your subscription. The Client Forms manager lists all your
saved forms—organized by client. The Profiles manager stores your client
profiles.

Client organized: IntelliForms organizes your data by client, the same way
you approach your workflow. All client forms for a single year are stored
together and can be accessed easily from the Client Forms tab.

Real time updates: IntelliForms checks for the newest version of a form
each time you open a form. You never have to worry that you are working
with an out-of-date form.

Archives: IntelliForms includes interactive versions of forms for 2005 to the
present. Also included as part of your IntelliForms subscription is access to
an online library of forms in PDF format going back to 1998.

Links to Tax Prep Partner: IntelliForms includes links directly from certain
commonly used Federal forms to explanatory, compliance-focused research
content related to the active field.

Thank you for choosing IntelliForms™!



|. GETTING STARTED — FIRST TIME USE

All you need to get started is to install the IntelliForms software from IntelliConnect,
by clicking the Install button for a standalone application or the Download button for
the network installation software.

Once IntelliForms is downloaded, to open the application, click the IntelliForms IF

icon on your desktop.

A. Access and Authorization
The first time you open the program, IntelliForms takes you to the Access tab of the
Preferences window. To begin using IntelliForms, you must enter your authorization

information.
Preferences
All Managers
Access Please enter orverify the applicable information below. This
: information may be updated as needed, for example, if you
Client Forms have changed your password. Click "Apply™ when you have

Print Manager
Open Client
Select Forms
Print

Input Box
Zoom

Internet

verified or entered the information.

Internet Login

IntelliConnect Userfame: |

IntelliConnect Password: ||

[ IP Authentication

2=
[=1
=1

|
[1e]
3
(=)
=
Lie]

| Browse

Apply Close Help

To enter your authorization information, do one of the following:

e If you are a CD user, enter your access code and click Apply, then Close.

e If you are an online user, enter your username and password and click

Apply, then Close.



e If you are a networked online user you may be able to authenticate your
subscriptions, by checking the IP box, and clicking Apply, then Close.

Once you have entered this information once, you do not have to enter it again
unless and until your subscription information changes. You can return to the Access
tab to change your subscription information by clicking the Preferences toolbar
button.

If at any time, IntelliForms is unable to verify your subscription information, you can
still access the program and any client forms you have previously saved. However,
the Blank Forms manager (and the Add Forms dialog box) will appear to be empty
and you will not be able to access any new forms.

B. Display Settings

The IntelliForms application is optimized for a screen resolution of 800 by 600 pixels
or better (Super VGA, using standard fonts). Higher resolutions display screen fonts
more clearly and show the full width of our forms. If your current screen resolution is
lower than this recommended setting, you should adjust the resolution.

To change the screen resolution and color settings (Windows® XP)

1. Right-click the background area of your desktop, and then click Properties.

2. Click the Settings tab.

3. Move the screen resolution slider to 800 by 600 pixels, or higher.

4. Under Color quality, select High Color (16 bit) or higher, if supported.

5. Click Apply. Your screen may turn black for a moment.

6. After your screen resolution changes, you have 15 seconds to confirm the
change. Click Yes to confirm the change. Click No or do nothing to revert to your
previous settings.

7. Click OK to close the Display window.

To change the screen resolution and color settings (Windows® Vista)

Right-click the background area of your desktop, and then click Personalize.
Click the Display Settings tab.

Move the screen resolution slider to 800 by 600 pixels or higher.

Under Colors, select Medium (16 bit) or higher, if supported.

Click Apply. Your screen may turn black for a moment.

After your screen resolution changes, you have 15 seconds to confirm the
change. Click Yes to confirm the change, otherwise click No or do nothing to
revert to your previous setting.

7. Click OK to close the Display dialog box.

oOuhsWNE

Many video card manufacturers replace the standard Windows display options with
customized boxes and menus. If your settings boxes do not resemble the examples
used here, follow the instructions in the Help files provided by the manufacturer of
your video card.



C. Select State Jurisdictions

If your IntelliForms subscription includes only a limited number of state jurisdictions,
the Select States dialog box prompts you to select the states you want to include in
your subscription the first time you open IntelliForms.

To choose the state jurisdictions to be included in your subscription

1. Click OK in the Select States dialog box.

2. IntelliForms displays the Select States tab of the Preferences window

3. Check the boxes for each of the state jurisdictions you want to include as part of
your subscription.

4. Click Add States.

Caution: Once you have selected a state as part of your subscription, you
cannot remove the state and select a new one in its place.

Click Close.

In the Caution box, confirm that you want to Continue Add State(s).
IntelliForms displays only the states to which you have subscribed in both the
Blank Forms manager and the Add Forms dialog box.

No g

You do not need to make all of your state selections at one time. You can choose to
make only one state selection at a time and return to the Preferences window to
access the Select States tab when you are ready to make additional state
selections.

You can also skip selecting states by clicking Close on the Select States dialog box.
However, you will not be able to access any state forms until you make at least one
state jurisdiction selection.

D. Setting Preferences
You can customize the way in which many IntelliForms features work by selecting
options from the program Preferences list.

To open the Preferences window
e From the Blank Forms manager, click the Preferences toolbar button.
e From the Client Forms manager, click the Preferences toolbar button.
e From the Profiles manager, choose Preferences from the Edit menu.

e From the Client View manager, choose Preferences from the Options
menu.



To select Preference options Preferences
1. Open the Preferences window (see above). All Managers
2. Click the appropriate tab. A Hanag
3. Select your Preferences. Access
4. Click Apply. Client Forms
5. Click Close, or click another tab to select additional Print Manager

Preferences. :

Open Client
For information about specific preference settings, click the Select Forms
Help button found under each Preference tab. Print
o ) ) Input Box

The following is a list of some of the Preference options Zoom
available in Intelliforms. See the Program Help for a
complete list and description of all Preferences options. Internet

Select Forms
The Select Forms tab of the Preferences window sets forth two preference options
with respect to opening forms in the Blank Forms manager.

Setting a Default State Jurisdiction

The default state preference option assigns a specific state to the State filter in the
Blank Forms manager (and the Add Forms dialog box). Even though you have
selected a default state jurisdiction, you can search the complete list of state and
local jurisdictions (included in your subscription) at any time, by clicking the state filter
check-box and selecting a new jurisdiction. To clear a default sate selection
altogether, return to the Select Forms tab in the Preferences window and select the
All option.

Show Selecting Client Type dialog box

In order to open blank forms for both new and existing clients in Blank Forms
manager, the Show Selecting Client Type preference must be checked. If the
preference is selected (the default), when you open a form in the Blank Forms
manager, IntelliForms prompts you to assign the form to either a new client or an
existing client.

If the preference is cleared, the Select New or Existing client dialog box is not
displayed and forms are automatically opened as new clients. If the preference is
cleared, you can only open new forms for an existing client when that client currently
open in the Client View. See: Adding Forms to a Saved Client, below.



Input Fields
The Input Fields tab of the Preferences window gives you several options for
changing the appearance of your data entry fields.

Input Box Color

The Input Box Color preference option allows you to choose from several colors to
be used to indicate the active input field.

Autosizing

If necessary to avoid truncating data, IntelliForms auto-sizes a data field to
accommodate the size of the figure by reducing the font (to a minimum of 6 pt) used
in the field. You can check the Disable Auto-sizing preference if you would prefer
that size of the font not be reduced. With the auto-sizing disabled, certain data entry
figures may be truncated.

Negative in Parentheses

IntelliForms generally displays negative values by using a negative sign (minus sign
in front of the figure). If you would prefer to use parentheses around a figure to
indicate a negative value, check the box for Negative in Parentheses.

Bold Input Fields

Checking the Bold input fields in all new and open forms preference box allows you
to use a bold font for all of your data input fields on a global basis.

Tip! Localized Bold Text Settings

You can choose to use bold text for input fields on a cell by cell or form by form
basis. In the Client View, point to the Edit menu; select Format Bold; click
Current cell or Current form.

Zoom

The Zoom setting determines the magnification at which forms and worksheets are
displayed on your screen. Zooming in or out on a form or worksheet does not affect
the appearance of the printed form or worksheet. The Zoom setting is saved and
applied globally.

Tip! Change Magnification Locally

To temporarily change the magnification setting for specific form pages only,
use the Enlarge Page and Reduce Page commands under the Tools menu in
the Client View manager.

All Managers
Show the Form Tabs on the Left - displays the form tabs to the left (vertically) of
the active form, rather than above the active form, in order to maximize workspace.



The Show Pop-up Tool Tip Help (in all managers and dialogs) - displays a small
Help window whenever the cursor hovers over certain buttons and menus.

Hide Clients Marked Complete - automatically hides those client entries on the
client grid that have been marked as Complete. Clear the Incomplete filter in the
Client Forms manager to temporarily show your completed clients.

Client Forms
Reset Default Sorting on Startup - resets the client list in the Client Forms
manager to alphabetical order on startup.

Internet Preferences
The Internet tab of the Preferences window offers you three choices for indicating
your type of Internet connection.

To set your Internet Preferences

1. From the Preferences window, click the Internet tab.
2. Check the box for your desired Internet preference, the options are:

* Always Download sets the preference to | have a continuous connection to the

Web.
» Ask Me First sets the preference to | have a standard modem connection to
the Web.
* 1 do not have a connection to the Web at any time.
3. After you make your selection, click Apply.
4. Click Close.

F. Setting up Printers

Before you begin printing forms, ensure that your printer is set up properly by
reviewing your printer settings. You can access your printer settings from both the
Blank Forms manager and the Client View manager.

To review (and change) printer settings from the Blank Forms manager

1. Click the Blank Forms tab.
2. Do one of the following:

e From the Forms menu, choose Change Printer; or
e Press Ctrl+P.

3. Inthe Print Setup dialog box, review your printer settings and change them, if
necessary.
4. Click OK to save your printer settings.

To review (and change) printer settings from the Client View
1. In an open client, click Print on the toolbar.

10
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necessary.

In the Print manager, click Change Printer in the upper right corner.
In the Print Setup dialog box, review your printer settings and change them, if

4. Click OK to save your printer settings.

G. Customizing your Back-Up Scheme

When you first install IntelliForms, the Backup feature is set to automatically back up
your client forms each time you close the program. To back up files on demand, use
the Backup/Restore Clients feature, discussed in Backing up Client Forms,

below.

You can change the default back-up settings to customize your Back-Up Scheme.
Select Backup / Restore Clients from the Clients menu in the Client Forms
manager. The back-up schedule options differ for Automatic and Manual back-up

schemes.

We recommend that you allow the program to back up automatically so you can be
assured your data is backed up regularly. As the volume of forms you prepare
increases, consider backing up more frequently. See: Backing Up Client Forms,

discussed below.

Follow the procedure below to customize an automatic back-up scheme. For specific
directions for setting a manual backup scheme, see the Program Help.

To customize automatic back-up schemes

1. Click the Client Forms tab.

. On the Clients menu, click Backup/Restore Clients.

2

3. Click Setup.

4. Under Backup Mode, select

Automatic.

Specify whether you want to:

* Run backup after program

closes; or

» Use schedule to run backup

6. Select the Day and Time you
want backups to be created.

7. Enter the number of Backup
Versions (1-5) you want to
retain.

8. Specify the backup file
destination.

9. Click Apply to save your
selections.

o

Backup Setup

" Manual

Automatic

Run backup after program closes & or use schedule to run backup

To ensure againstfile loss, if you choose to back up your files when the
program closes and the program is still running during the period specified in
the Day and Time windows, an additional backup will be performed at that

time.
~|at|z00Am  ~]

Maximum number of versions for each client: |3

Run every |Day

(Range: from 110 5)

j Browse

Help

Please select default destination for the backup:
|C:\.F'rngram Files\ntelliForms\Backuph

Apply Restore Defaults ‘ Close |

11




Tip! Additional Protection
To provide additional protection against loss of data, back up to a removable
disk and store off-site.

H. Administration and Security

In multi-user offices, at least one user should be designated as an administrator. If no
one user has been designated as an Administrator, IntelliForms treats all users as
having administrative privileges until at least one user is so designated.

In general, Administrators have unlimited privileges when using the program.
Among other things, Administrators can remove client passwords and designate
administrator rights to other users. Subsequent administrators have the same rights
as the initial administrator.

To designate another user as an administrator

Click the Client Forms tab.

From the Options menu, point to Administration, and click User Maintenance.
IntelliForms displays the User Maintenance dialog box.

Check the box for Administrator to the right of any name listed.

Click Close.

arwnE
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Il. THE INTELLIFORMS WORKSPACE — THE MANAGER VIEWS

When you open IntelliForms, you see the Blank Forms manager. At the top of the
program window and next to the tab for the Blank Forms manager, there are
additional tabs for Client Forms, and Profiles. These tabs, along with the Client

View manager tab, which is visible whenever a client’'s forms are open, represent the
four main user interfaces of IntelliForms.

IntelliForms 2009

Blank Forms Client Forms Profiles

Forms View Support
e @ — 2
Opén I.furms Clear Al Preferences  Tutors Instructions Help
11908 of 11908 Formz  Wame Description
11-C, 11-C{V) Occupation TawReg. Rin for Wagering
Year 2008 E 23 Application for Enroliment Practice/IRS
56 Motice Concerning Fiduciary Relationship
Find: A6-F Motice-Fid. Relationship-Financial Inst.
- 211 Appl. for Reward for Original Info
211 (SP) Solicitud de Recompensa por Information
433-A Collection Information for Individuals
Federal 433-B Collection Information for Business
State 433-D Installment Agreement
Local A1 [=] 433D0sP) Plan de Pago a Plazos
433-F Collection Information Staterment
Individual 637 App. for Registration (Excise Tax Act.)
Corporation G656 Offerin Compromise

The managers help you organize your form and client management tasks.

Navigate to a specific manager at any time by clicking the appropriate tab.

Use the Blank Forms manager to search for and open blank forms, add

Status

Available
Available
Available
Available
Available
Unavailable
Available
Available
Available
Unavailable
Available
Available
Available

PDF

View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr

new forms to existing clients, print blank forms, or open the instructions to a

form.

Use the Profiles manager to create profiles for your clients and the
professionals in your practice, import profiles created in other applications,
such as CCH'’s perform plus Ill, ATX's ZillionForms, and SuperForms, edit

saved profiles, and apply profiles to open forms.

Use the Client Forms manager to access the forms you have saved for
each of your clients, review the contents of a client's form set, quickly

determine which clients’ forms have been completed, and export and import

client forms to and from other instances of IntelliForms.

Use the Client View manager as the place to accomplish all of your work

on your clients’ forms.
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A. Using the Find Box and Filters in the Manager Views

Each of the three main manager views (Blank Forms, Client Forms, and Profiles)
includes a Find box to help you quickly locate the form, client, or profile you want to

open. In addition, the Blank Forms and Client Forms manager view also have

search filters that can work in lieu of, or in conjunction with, the Find box to help you
locate the form or client you want to open.

IntelliForms 2009

Blank Forms Client Forms Profiles
Forms View Support
- 5)
L] ] Bg = ¢
Open Forms  Clear All Preferences  Tutors Instructions Help
52 of 11908 Forms Mame Description Status
Sch EIC (1040/1040A) Earned Income Credit - Child Information Available
Year 2008 E Sch R (1040) Creditfor the Elderly or the Disabled Available
Sch 3 (10404) Credit for Elderly or Disabled (10404) Available
¥ Find: 1116 Foreign Tax Credit Available
F|nd 7_ = 3468 Investment Credit Available
3800 General Business Credit Available
4136 Credit for Federal Tax Paid on Fuels Available
v Federal 4255 Recapture of Investment Credit Available
( State 4746 Questionnaire - Credit for Care Expenses Available
Local A E 5405 First-Time Homebuyer Credit Available
5695 Residential Energy Efficient Ppty Credit Available
+' Individual 5884 Work Opportunity Credit Available
Corporation 6478 Credit for Alcohol Used as Fuel Available
S Corporation 6765 Credit for Increasing Research Activity Available
Partnership 8046 Change to Credit for the Elderly Auailable
Fiduciary 8396 Mortgage Interest Credit Available
8582-CR Passive Activity Credit Limitations Available
SearCh gz?;:“p;l?drgUse 8586 Low-Income Housing Credit Available
Fl |ters Payroll 8609 Low-Income Heusing Credit Allocation Available
8609-A Annual Stmt/ Low-Income Housing Credit Available
Pension/Benefit 8610 Annual Low-Income Housing Credit Report Available
Estate 8611 Recapture of Low-Income Housing Credit Available
Gift 8801 Credit for Prior Year Minimum Tax Available
Applications 8812 Additional Child Tax Credit Available
Miscellaneous 8820 Orphan Drug Credit Available
Practice Aids 8823 Low-Income Housing Credit Agencies Available
Spanish 8826 Disabled Access Credit Available
K 8834 Qualified Electric Vehicle Credit Ayailable
8845 Indian Employment Credit Available
SelectedForms  ggyp Credit for Emplayer S.5. Tax Pd. on Tips Available
8847 Credit for Contributions to CDC Available
Show All Forms 8859 DC First-Time Homebuyer Credit Available
8861 Welfare-to-Work Credit Available
8862 (SP) Informacion Para Reclamar el Credito Available
8863 Education Credits Available
8864 Biodiesel and Renewal Fuels Credit Available
8874 MNew Markets Credit Available
8880 Credit Qualified Retire. Savings Contrib Available
8881 Credit for Small Employer Pension Plan Available
3882 Credit for Employer-Provided Childcare Available
8885 Health Coverage Tax Cradit Available
8896 Low Sulfur Diesel Fuel Production Credit Available
8y "QuickStart Guide O... Ly “Flash Demo Outline ... P IntelliForms 2009

To locate a form, client, or profile using Find
1. Begin entering the search text in the Find box.

2. As you enter characters in the Find box, the results list displays only those
records that include the search text in one or more information fields.
3. To restore the full list of records (that is, forms, clients, or profiles) for the

manager, click the Show All [records] button.

PDF

View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr
View Instr

Below the Find box are filters relevant to the types of records found in that manager.

To locate a form or client using the search filters

Use the filter check boxes on the filter pane to temporarily hide certain records. When
one or more filters are selected, the forms or clients not meeting the filter criteria are

14



removed from view and are not displayed in the results list. To display all the records
of the manager, click the Show All [records] button.

B. Sorting in the Manager Views

You can sort the records in the Client Forms and Profiles managers by clicking a
column heading. For example, to display your clients in the Client Forms manager
chronologically, according to the date on which they were last modified, click the
Modified column heading. To reverse the order in which records are sorted, click the
column heading a second time.

Tip! Resizing and moving columns in the manager grids.

You can adjust the columns in both the Profiles grid and the Client Forms grid.
You can also show, hide, and create custom columns in Client Forms
manager. You cannot re-size or move the columns in the Blank Forms grid.
Resize columns by clicking and dragging the dividing line to the right of the
column you want to resize. Move columns by positioning the cursor over the
column heading, clicking and dragging the column to its new location. To reset
columns to their original size and position, click Reset Fields on the Options
menu. Reset fields restores the manager grid columns to their default field
sequence, width, and visibility. It does not delete the fields or the data

C. Blank Forms manager

Use the Blank Forms manager to search for, find, and open a wide array of federal,
state, and local forms and instructions. After selecting a year, you can search for a
form by:

e Jurisdiction — federal, state, or local;

e Category — individual, corporate, partnership, fiduciary, estate, tax-exempt,
etc.;

e Description or number; or

e any combination of these search parameters.

The right side of the Blank Forms manager displays a list of all of the forms within
your subscription.

Use the Find box and the form filters (found on the filter panel on the left) to narrow
your form selection choices and help you find the forms you need to open now. When
you use these search tools, only those forms within your subscription that meet your
search parameters are displayed in the forms grid on the right.

Click Show All Forms to clear your filter selections and return to view the full list of
forms within your subscription.

15



Finding Forms

The Blank Forms manager filters make it easy to find specific forms quickly. The
forms filters can be combined to allow multi-level searching. For example, by using
multiple filters you can isolate all New York corporation tax forms with titles that
include the word "franchise."

IntelliForms 2009

Blank Forms Client Forms Profiles

Forms View Support
- o =)
i ® F 9
Preferences  Tutors Help
12 of 11308 Forms Mame Description Status PDF
MY CT-185 Cooperative Agricultural Corp. Franchise Available View Instr
Year 2008 E Y CT-186 Utility Corporation Franchise Tax Rin Available View Instr
CT-247 App/Exemption from Corporation Franchise Available Wiew Instr
NY ET-3 General Busn Corporation Franchise Tax Available View Instr
NY £T-3-C Consolidated Franchise Tax Return Available View Instr
NY £T-32 Banking Corporation Franchise Tax Return Available View Instr
MY £T-32-A Banking Corporation Combined Franchise Available Wiew Instr
Federal NY €£T-33 Life Insurance Corporation Franchise Tax Available View Instr
v State MY £T-33-A Insurance Corp. Combined Franchise Tax Available View Instr
¥ Local NY E NY £T-33-C Captive Insurance Co. Franchise Tax Rin Available View Instr
MY £T-33-ML Mon-Life Ins. Corporation Franchise Tax Available Wiew Instr
Individual NY €T-4 General Business Corp. Franchise Tax Available View Instr
\ | Corporation
S Corporation _/
Partnership
Fiduciary
Exempt Org
Sales and Use
Payrall
Pension/Benefit
Estate
Gift
Applications
Miscellaneous
Practice Aids
Spanish

Selected Forms

Show All Forms

After you find the forms you want, you can:
e open them to create a new client;
e add them to an existing client;
e print them without opening; or
e download the instructions.

To use the forms search filters

1. Click the Blank Forms tab.
2. Select the Year, if different from the current default year.
3. Apply the following filters, as appropriate

e Select one or more of the desired jurisdictions (Federal, State, or Local).

e Select a specific state from the State/Local drop-down box, if desired.



Note: If you have selected a default state jurisdiction as a preference (see:
Setting Preferences, above) that state is automatically selected in the
State/Local drop-down box. However, you can change this selection to any
other state jurisdiction included in your subscription. See also: Select State
Jurisdictions.

e Select one or more form category (such as Individual, Corporation, or
Partnership).

4. Enter a keyword in the Find box, in addition to using the filters, or in lieu of using
the filters.

5. IntelliForms displays the forms within your subscription that meet your selected
search parameters.

6. After you have found the form, click the form's listing in the search results grid to
select. You can select more than one form.

7. IntelliForms saves your form selections and you can move on to searching for
additional forms, clearing your form filters (but not your year) settings, as
necessary.

8. To clear all of your selected filters, click the Show All Forms button.

Tip! Do multiple searches at one time.
IntelliForms allows you to do several form searches and to make multiple form
selections at one time — opening or printing the forms all together — so long as
the forms are all for the same tax year, and are for the same client. The client
can be a new client or an existing client.

Multiple Searches and Form Selections

You can continue to search for, and select additional forms, as many as you need, so
long as the forms are all for the same client and the same year. To start a new forms
search, simply make new filter selections. IntelliForms keeps track of your prior form
selections.

Caution: The only filter you cannot reset for your subsequent form searches is
the Year selection. Only forms of the same tax year may be saved as part of a
single client's form set. Forms from different tax years must be saved as a
separate client. If you attempt to reset the Year as part of any subsequent
search, IntelliForms will clear your prior form selections.

You can review a list of your form selections at any time by checking the Selected
Forms box. Clicking any form removes it from the Selected Forms list.

Once you have made all the form selections you want, you can open the forms, print
a list of the forms, or print the actual forms.
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Opening Blank Forms
To open Blank Forms, you can:

e Use the Blank Forms manager to find and open forms for both new and
existing clients.

e Use the Add Forms function in the Client View manager to find and open
forms for existing clients.

To use the Blank Forms manager to open new forms for both new and existing
clients, the Show Selecting Client Type preference (under the Select Forms tab in
the Preferences window) must be checked.

Caution: Although the Select New or Existing Client dialog box gives you the
choice of assigning a new blank form to a new or an existing client when you
first open the form, you do not get this choice at any other time. Once you have
opened a form, you cannot transfer it to different client.

To open a blank form for a new client

1. Click the Blank Forms tab.

2. Use the Find box and the form filters to find the form(s) you need.

3. Click to select the form(s) in the search results grid.

4. Do one of the following:
 Click your form selection again (that is, double-click).
» Click Open Forms on the toolbar.
* On the Forms menu, click Open Selected Forms.
* Press Ctl+O.

5. Inthe Select New or Existing Client dialog box, click Add Forms. Note that the
New Client radio button is already selected.

6. IntelliForms opens the new form(s) in the Client View, under a tab entitled
‘Unnamed Client.” The first time you save the forms, you will be prompted to name
the client.

To open a blank form for an existing client

Ensure that the Show Selecting Client Type preference under the Select Forms
tab in the Preferences window is checked.

Click the Blank Forms tab.

Use the Find box and the form filters to find the form(s) you need.

Click to select the form(s) in the search results grid.

Do one of the following:

* Click your form selection again (that is, double-click).

» Click Open Forms on the toolbar.

* On the Forms menu, click Open Selected Forms.

* Press Ctl+0O.

6. Inthe Select New or Existing Client dialog box, select the Existing Client radio
button.

=
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7. IntelliForms populates the dialog box with a list of your clients from the Client
Forms manager.

8. Use the Find box or scroll through the list to locate the client to which you want to
add the form.

9. Click to select the client.

10.Click Add Forms.

11.IntelliForms opens the new form as part of the client's previously saved form set
in the Client View.

You can also add new blank forms to an existing client whenever the client is open in
the Client View. See: Adding Forms to a Saved Client, below.

Opening Forms already saved for Clients

Forms you have previously opened and saved for a client are not opened in the
Blank Forms manager. Instead, click the Client Forms tab to see a full list of all the
clients for whom you have previously saved forms. Using the Find box, client filters,
the scroll bar, or some combination of these, find the client. Click to select the client
in the grid and click Open on the Client Forms’ toolbar. All of the forms you have
saved for this client open in the Client View manager. See also: Opening Client
Forms, below.

Opening Non-Reproducible Forms
For non-reproducible forms, the process of opening the form is similar to that of any
other type of form — except that it includes an additional step.

Specifically, just as it does when opening a regular form, when selected, IntelliForms
opens the non-reproducible form in the Client View. However, unlike regular forms,
the non-reproducible form displays a link that opens a pdf version of the form from
the Web.

Opening Form Instructions

IntelliForms gives you several ways to access the Instructions to forms. Each time
you open instructions to any form, the program automatically downloads the most
current version of those instructions. There is no need to manually update your forms
or your form instructions.

In the Blank Forms manager you can open the Instructions to a form without first
opening the form.

To access the instructions to a form without opening the form

1. Click the Blank Forms tab.
2. Find and select the form with respect to which you want to view the instructions.
3. Do one of the following:

* Click the Instructions toolbar button;

19



» Select Open Instruction or Publication from the Forms menu; or

 Click the View Instr link for the form under the PDF column of the forms grid.
4. IntelliForms displays Support Explorer.
5. If you clicked the pdf link in Step 3, IntelliForms opens the Instructions as a pdf file
without first displaying the Support Explorer window.
Click Instructions on the Support Explorer navigation panel, IntelliForms
displays the Instruction List dialog box.
Select the appropriate jurisdiction (Federal or state).
Highlight the instruction you want to open.
. Click Open.
0.IntelliForms displays the Instructions as a pdf file.

o

Tip! Open Instructions from any manager view

You can open form instructions from any IntelliForms manager view.

In the Client Forms and Profiles managers, choose Instructions from the
Support menu and follow the directions for Steps 4 through 10 above. In the
Client View manager, click Instructions on the Client View toolbar and
IntelliForms displays the instructions to the active form as a pdf file.

Opening Prior Year Forms & Publications
Use the Year filter (under the Blank Forms tab) to find forms for tax years 2005 and
later.

You can also access forms and publications for 1998 to the present using the Online
Library. The Online Library is a searchable database that provides you with
immediate access to pdf versions of both current forms and an archive of more than
20,000 federal or state forms, instruction booklets, and IRS publications.

To access the Online Library from any manager
1. On the Support menu, point to Websites.

2. Select Current and Archive PDF files.

3. IntelliForms links you directly the Online Library.

Updating Forms

With IntelliForms, there is no reason to worry about form (or program) updates. Every
time you open a new form, IntelliForms ensures that you receive the most up to date
form available anywhere. Moreover, unless you have marked your client as
Complete, every time you open an existing client’s saved forms IntelliForms
automatically updates the forms in that client’s form set and transfers the client’s data
to the most recent versions of the forms. See: Updating Client Forms, below.

D. Client Forms Manager
After you have used IntelliForms to create and save forms for a client, you can
access your client’'s saved documents using the Client Forms manager. The Client
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Forms manager is more than just a list, as it features several tools to assist you with
managing your workflow.

In addition to providing easy access to your clients’ forms and documents, the Client
Forms manager allows you to review the contents of a client's form set without
opening the client, to quickly determine which of your clients’ have been completed,
and to transfer client forms.

Among the tasks you can accomplish in the Client Forms manager, are the
following:

e Open saved client forms

e Rename clients

e Duplicate a client’s form set

e Delete a client’s form set

e Mark a client as Complete

e Import and Export client forms

e Backup and Restore client forms

e Print a client list

e Export a client list
Some of these features are covered briefly below. Please see the Program Help for

comprehensive discussions on all of the functions of the Client Forms manager.

Tip! Adding Forms to an Existing Client

You do not use the Client Forms manager to add forms to a saved client.
Instead, you can add forms to an existing client’s form set by opening a blank
form in the Blank Forms manager and assigning to the client, or by first
opening the client in the Client View and clicking the Add Forms toolbar
button.

The Client Forms manager is divided into three sections — the client filters, the
client grid, and the Forms Pane.

The client grid displays a list of all the clients for whom you have saved at least one
form. You can customize this view. See: Customizing the Client Forms Grid,
below.

Select any client listed in the client grid and a list of all the forms and pdf files you
have saved for the client is displayed in the Forms Pane.

Use the Complete, Incomplete, and Marked Clients check box filters to sort the list
of your saved clients. Checking any of these filters hides the client records that do not
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meet the search criteria from view on the client grid. Click Show All Clients to clear
the filters and display the full list of clients in the grid.

Tip! Marking versus Selecting

In order to perform a command on more than one client at a time — a batch
operation — you can mark the clients in the Client Forms manager. You can
also mark Profiles in the Profiles manager in order to accomplish a task on
more than one profile at a time. To mark a client in the Client Forms manager
or a profile in the Profiles manager, click the check box to the left of the record.
Selecting, as opposed to marking, refers to the process of choosing a client or a
profile so that you can perform a command or accomplish a task with respect to
only that client or profile.

Opening Client Forms

Forms you have previously opened and saved for a client are opened in the Client
Forms manager. Click the Client Forms tab to see a full list of all the clients for
whom you have previously saved forms.

To open forms you have already saved for a client

1.
2.

Click the Client Forms tab.

Find the client you want to open by doing one (or more) of the following:

 enter the client’'s name in the Find box;

* use the scroll bar to scroll through the list of clients on the grid;

» use the Complete / Incomplete filters, and/or the Find box,

* click on a column heading to sort the client grid.

After you have located the client, click the entry on the client grid to select, and do
any one of the following to open:

* click again (that is, double-click);

* click Open on the toolbar;

» choose Open Selected Client on the Clients menu; or

* Press Crtl+O.

If you used the Password feature when you saved the client, enter the password,
and click OK.

Opening Forms for Multiple Clients and/or Multiple Years
With IntelliForms you can work on multiple clients’ forms at one time.

The ability to work on up to five client's forms at one time is especially helpful when
comparing data for related taxpayers. This feature also allows you to view multiple
years of the same client at one time.

TIP! Forms for different years — even when for the same person or entity —
are different clients

You can open different years for the same client, as the program treats form
sets for different years as separate clients. However, you cannot open multiple
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instances of the same client's form set. When a client's form set is opened by a
user, it is automatically locked and cannot be accessed by another user.

To open an additional client

1. Click the Client Forms tab.

2. Find and select the additional client you want to open.

3. Click Open and IntelliForms displays the Open Client dialog box.

4. You can choose to:

» Swap the current client for the new client — this automatically closes your
current client; or

* Open the additional client in a new window.

Click the New Window button in the Open Client dialog box.

IntelliForms displays a second instance of the program without affecting anything

in the original window.

7. You can continue to open additional — up to a maximum of five — client form sets.

oo

Marking Completed Clients

When you complete all of the forms you want to prepare for a client, you can mark
the client as complete by checking the Complete check box for that client in the
client grid.

Marking a client as complete prevents IntelliForms from updating those forms each
time the client is opened. See: Updating Client Forms, below.

Marking a client as complete also allows you to quickly determine which your clients
still need your attention. Use the Complete and Incomplete check box filters in the
Client Forms manager to sort your clients accordingly.

Tip! Making Changes to a Completed Client
Although a client marked as Complete may be modified, you cannot save those
modifications until the Complete status is cleared from the check box.

Customizing the Client Forms Grid

IntelliForms allows you to customize the client grid to display the information you
find most useful. Not only can you resize and move the columns on the gird, but you
can create custom fields to be included on the grid. You can also hide any field
(custom or standard) on the grid.

To create custom fields

1. Click the Client Forms tab.

2. On the Options menu, click Customize Fields.

3. Inthe Customize Fields utility, check the box next to the custom field you want to
add.

4. Click Rename.

5. Enter the new field name and click Rename in the Rename Field dialog box.
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6. Check another box if you want to add a second custom field, or click Close.

To reset columns to their original size and position

1. On the Options menu, click Reset Fields.
2. Click Reset when prompted to confirm your decision.

The Reset fields command restores the client grid columns to the default field
sequence, width, and visibility. It does not delete the fields or the data. Resetting the
fields to their default settings only hides custom fields, it does not delete them. To
restore your custom fields to the grid after using the Reset command, return to the
Customize Fields utility and check the box of the custom field you want to be
displayed as part of the client grid once again.

Transferring Client Forms

Use the Export and Import functions under the Client Forms tab to transfer client
forms and documents from one computer to another. This feature makes it easy to
transfer work between your office computer and your home computer.

When used with the Mark Client function, the Export / Import client forms feature
allows you to simultaneously transfer data for several clients.

Caution: The Export feature does not save critical information and it is not

suitable for permanently archiving client forms. To permanently archive your
clients' forms use the Backup feature found on the Clients menu under the
Client Forms manager. See: Backing up Client Forms, below.

To export client forms

1. Click the Client Forms tab.

2. Mark the client or clients you want to export by checking their respective boxes on
the client grid.

On the Clients menu, click Export Marked Clients.

Select the destination drive and folder, and click OK.

The file names of exported clients will resemble JohnandJaneDoe.csv.

ok w

To import client forms

1. Click the Client Forms tab.

2. On the Clients menu, point to Import, and click Single Client or Batch Client.
3. In the Import Client window, navigate to the appropriate drive and folder.

4. Select the Client Forms files (*.csv) you want to import.
5. Click Open.
6. Confirm that you want to Import the Client Forms.
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Backing- Up Client Forms
It is recommended that you allow the program to back up automatically so you can be
assured your data is backed up regularly. See: Setting a Backup Scheme, above.

As the volume of forms you prepare increases, consider backing up more frequently.

To back up Client Forms

1. Click the Client Forms tab.

2. On the Clients menu, click BackUp/Restore Clients.

3. In the Backup window, click Select All to select all clients, or search for a specific
client by entering the name in the Find box.

4. Click a client to toggle its selection status. Selected clients are highlighted in dark
blue.

5. Inthe Backup to dialog box, specify the desired backup folder.

6. Click Start.

7. When the backup is complete, click Close.

Ideally, backup files should be stored off-site. If you choose to do so, you can
customize your backup scheme by specifying destinations, such as network drives or
removable storage devices.

Restoring Client Forms
You can restore only those client forms that have been archived using the
IntelliForms Backup feature.

Caution: Do not use Restore to retrieve an exported client. Instead, to retrieve
an exported client’s form set, use the Import command on the Clients menu.

To restore backed-up Client Forms

1. Click the Client Forms tab.

2. On the Clients menu, click BackUp/Restore Clients.

3. Inthe Restore window, click Select All to select all clients, or search for a
specific client by entering its name in the Find box.

4. Click a client to toggle its selection status. Selected clients are highlighted in dark
blue.

5. Click Start.

6. When the restoration is complete, click Close.

E. Profiles Manager
IntelliForms allows you to create and store Profiles for your clients and for you, and
the other professionals in your office, as preparers.

These Profiles contain personal data that can be easily transferred to forms again
and again — streamlining your workflow and saving you significant amounts of time.

25



You can apply multiple profiles to a form and each profile can be applied to an
unlimited number of forms.
Use the Profiles manager to:

e create new Profiles;

e edit existing Profiles;

e apply Profiles to open forms; and

e transfer Profiles.

You can also import profile data that you have created in other applications, such as
CCH's perform plus Il and ATX's ZillionForms.

Select Profile

Profile types
The Profiles manager displays sub-tabs for each Select the type of profile to be created:

type of profile available within your subscription. -
IntelliForms offers the following profile types.

e Individual oK Cancel
e Business
e Preparer

e Broker/Dealer
e Investment Advisor
e Registration/Exemption and

e Government Contracts.

Profiles that you have created and saved and those that you have imported from
other CCH/ATX applications can be found under their respective profile tabs. Click
the Profiles sub-tabs to display and access the Profiles that have been saved for
each profile type.

Tip! Payroll profile information

Payroll profile information saved in other CCH/ATX applications and imported to
IntelliForms is segregated between the Business (employer information) and
the Individual (employee information) profile tabs.

Creating& Editing Profiles
You can create Profiles to store both client and preparer information. You can edit
your saved Profiles any time the Profiles tab is the active view. Apply the Profiles to
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your client's forms to automate repetitive data entry tasks. Each profile can be

applied to an unlimited number of forms. You can apply multiple Profiles to a form.

To create a new profile

1. Click the Profiles tab.
Click the Add New toolbar button.

2.
3. Select the profile type you want to create from the Select Profile type dialog box.
4.

The Add Profile type data entry worksheet is displayed.

[ Add Individual Prefile

Taxpayer Spouse
* First Name:l First Name:|

Middie inftal| Middle Inffial|
*Last Name:l LastName:|

Suffix: Ii Suffix: ,7
ssw[ ssw[
Address: | Occupation: |
Apartment Number:li Daytime Telephune:|
City: | Email Address: |
Stat&:l_ Age 65 or Oider:[~
Zip Cude:li Blind:[~
Pruvince:l Business
o Name:l Business Name:|
School District Code:| Address Line 1:]
Occupatiun:l Address Line2:|
Daytime Telephune:l CW;'
Email Address: | TEE ,_
Age 65 or Older:[— EoEnE
cewel
* Indicates Required Fields DK Cancel Help

5. Enter the appropriate information.

6. Ensure that you have entered data in each required field; required fields are
marked with an asterisk.

7. When you have finished, click OK.

To edit a profile

Click the Profiles tab.
2. Using the Profiles sub-tabs (such as, Individual, Business, and Preparer)
navigate to the type of profile you want to edit.

=

3. Use the scroll bar or the Find box to locate the specific profile you want to edit

from among those saved as the same profile type.

4. Click to select the profile you want to edit.

5. Do one of the following to open the profile for editing:
* Click the profile again (that is, double-click).
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¢ Click Edit on the toolbar.

* From the Profiles menu, choose Edit Selected Profile.
6. IntelliForms displays the Edit <Profile type> worksheet.
7. Make your changes to the profile worksheet.
8. Ensure that you have not deleted a required field; required fields are marked with

an asterisk.
9. Click Save.

10.Use the navigation arrows at the bottom of the worksheet to move to additional
Profiles of the same type that you want to edit, or click Close.

Edit Individual Profile

Taxpayer

* First Name: |Peter

Middle intiak[

* Last Name: |P|_| blic

Suffic
SSN:|566-77-3888

Address: |12 Perwinkle Court

Apartment Number:

City: |F_|ru\-.'n'.rille

State: |ND
Zip Code: (78789

Province: |

County Name: |r.1arker

School District Code: |

Occupation: |Artist

Daytime Telephone: |(627) 345-6758

Email Address:|

Age 65 or Older: v

* Indicates Required Fields| Navigation Arrows | {m )

Spouse

First Name: |Pau|a

Widdle Initial: ’5_

Last Name: |Pu blic

Suffic
SSM:|777-83-9999

Occupation: |Teﬁch er

Daytime Telephone: | (527) 345-6758

EmaiIAddress:|
Age 65 or Older:[—
Blind: [~

Business

Business Name:|

Address Ling 1:|

Address Line 2: |

City:
State: ’_
Zip Code:

(S8

11.Make the changes to additional
profiles, if desired, and click Save.
12.When you have finished, click Close.

Importing Profiles

You can import profile information from
other applications. You can also import
profile information from IntelliForms, as a
way of transferring profile data between
non-networked computers.

To import profile data

1. Click the Profiles tab.
2. On the Profiles menu, click Import

»}- Save

Select Import

" SuperForms

i ZillionForms

" IntelliForms

Mext

Selectthe product from which you waould
like to imponrt profile data.

Cancel
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Profile Data.

3. Inthe Select Import dialog box, select the program from which you would like to
import profile data.

4. Click Next.

5. Depending on the program data you would like to import, IntelliForms displays the
Import dialog box for that program or Windows Explorer.

6. If the Import dialog box is displayed, select the Profiles you want to import (or
check Select All) and click Import.

7. 1f Windows Explorer is displayed, navigate to the location of the profile data you
want to import, and click Import.

8. IntelliForms displays the Import Status Report.

9. Click Done to dismiss the Import Status Report and return to the Profiles
manager.

10.You can review the imported data for completeness by navigating to the
appropriate profile-type tabs, where IntelliForms has automatically saved the
imported profiles.

To review imported profile data

1. Navigate to the tab for the profile type you want to review.

2. Find and select the profile you want to review.

3. Click Edit on the toolbar.

4. IntelliForms displays the data worksheet for the profile. Review the imported data,
make changes, and/or add additional information, as needed. Click Save. Use the
navigation arrows at the bottom of the worksheet to move to additional profile you
want to review, or click Close.

Transferring Profile Data

As discussed above, you can use the Import Profiles function to transfer profile data
between computers, so long as both computers have IntelliForms installed. In order
to import IntelliForms profile data, the profiles must have been exported using
IntelliForms.

You can export a single profile, all saved profiles, or mark a select group of profiles to
export in a single operation.

To export profile data

1. Click the Profiles tab.

2. Navigate to the profile sub-tabs for the profile types you want to export.

3. Check the box to mark each of the profile(s) you want to export. You can navigate
between the profile type sub-tabs to mark different types of profiles for export in a
single operation.

4. From the Profiles menu, choose Export Marked Profiles.

You do not need to mark all of your saved profiles if you want to export them all at
one time. Instead, use the Export All Profiles function.
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To export all saved profile data
1. Click the Profiles tab.
2. From the Profiles menu, choose Export All Profiles.

Applying Profiles to Forms
Once you have saved a profile for any client or preparer, it is very easy to apply the
profile to an open form.

To apply a profile to an open form

Click Apply Profile on the Client View toolbar.

IntelliForms displays the Profiles manager.

Click the profile tab for the profile type you want to apply to the form.

Use the scroll bar to locate the specific profile you want to enter on the form.
Select the profile by either clicking the profile or checking the box.

The profile is highlighted.

Click Enter on Form on the Profiles toolbar.

IntelliForms automatically returns you to the active form where the profile data has
been entered in the appropriate fields.

N A WNE

You can repeat this process to add additional Profiles to the same form. For
example, after applying your client's profile to a form, you may want to add the
preparer information to the same form.

F. Client View Manager

After you have opened a form for a client, IntelliForms displays the form — along with
any other forms you have saved for this client (the client form set) — in the Client
View manager. The Client View is where you accomplish all of your work on your
clients’ forms.

The Client Form Set

A client’s form set is the set of forms that you have saved for that particular client —
either by opening the forms altogether or by adding forms one at a time to those you
have originally saved for the client.

You can save forms of any type together as part of a client’s form set, but you cannot
save forms of different years together — even if they are the same type. Thus, for
example, a client’s form set could include such diverse forms an individual income
tax return on Form 1040, the income tax return for the client’s business on Form
1120S, the business’ payroll tax return on Form 941, and the client’s personal gift tax
return on Form 709, so long as the returns were all for the same year. But, a form set
could not be made up of the client’'s 2009 and a 2008 Form 1040 — even if these
were to be the only two forms in the set.
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Note, too, that IntelliForms refers all to tax forms, information returns, schedules, and
statements as forms. Thus, not only is an individual tax return, such as a Form
1040A, included within any reference to a form, but so, too, is a Schedule 2 (Form
1040A) considered to be a form. All forms are listed and accessed separately under
the Blank Forms tab.

Any worksheet that opens automatically along with a form is not considered to be a
form, per se. Instead, such worksheets are more akin to the individual pages of a
form. Specifically:

e worksheets are attached to, and open with, the parent form;

e worksheets are saved as part of the parent form and are accessed under
the parent form’s tab; and

e data entered or calculated on a worksheet transfers to the appropriate
places on the parent form.

How Data Transfers in the Client View

IntelliForms carries data between a form and its supporting worksheets. Supporting
worksheets are those worksheets and schedules which open automatically when the
form is opened. Data entered or calculated on a distinct form does not transfer to
another form, even when both forms are part of the same client form set.

Any form or schedule that must be opened as a separate and distinct form does not
carry data to, or from, another form within the client's form set.

For example, when a blank Form 1040 is opened, the ‘Line 6¢c — Dependents’
worksheet is automatically opened. Data entered on the ‘Line 6¢ —
Dependents’ worksheet transfers to the applicable lines of the Form 1040.
However, if a blank Schedule C (1040) is opened and added to the set of this
client’s forms, any data entered on the Schedule C does not transfer to the
Form 1040. Although they are ultimately filed together as part of the same
return, they are separate forms — each with their own tab — within the client’s
form set.

Navigation in the Client View

Navigating - Form to Form

To navigate between the forms in a client's form set, click the form tabs. The form
tabs are located above the active form and below the Client View toolbar.

Navigating - Page to Page of a single form

The navigation bar, which appears below the active form, consists of the Pages &
Worksheets button and a series of tabs. Each of these tabs is associated with a
numbered form page, schedule, or worksheet that is part of the active form.
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To navigate through multiple pages of an active form, do one of the following:

e Using the navigation bar, click the tab for the page or worksheet you want to
access.

e Use the tools on the Navigate menu.

e Click the Pages & Worksheets button to the left of the navigation bar; from
the list displayed, select the page or worksheet you want to access.

e Press Ctrl+W to display a Pages & Worksheets list.

TIP! Navigating to Page 1 of the active form.

To navigate to page 1 of the active form, in addition to the usual navigation
methods, you can also Right-click anywhere on the form, and then select <Form
Name>, page 1.

Navigating within a single page
To navigate through a single page of a form, do one of the following:

e Press Enter or Tab to move from the current field to the next field. To
reverse direction, press Shift+Tab.

e Click in a field or use the arrow keys to move the cursor to a specific field.

e Press Page Up and Page Down to scroll through a page quickly.

Navigating using the Jump To command

When the value in a green (calculated) field is derived from a linked source, typically
a worksheet, you can use the JumpTo command to move to the worksheet.
IntelliForms displays the Jump To icon (a small bunny) when you click in a linked
field. Click the Jump to bunny and the source of the calculated field entry is
displayed.

If the calculated field is derived from multiple sources, use the Jump To command to
display a list of sources contributing to this value, and then click the list to navigate
directly to the desired source.

Navigate using the Back and Forward buttons

Use the Back and Forward buttons on the toolbar to move back and forth between a
form and worksheets and between separate forms, in the order in which you last
viewed them.

The program records a limited history of your movements through a client's form set

during a work session. When you close the client, the history is gone, but the
program begins recording a history again when you reopen the client.
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Data Entry

Data fields are color-coded according to the type of information they contain. Fields
that accept user input without overrides have blue backgrounds. In general, you
should only enter data in blue fields. The following list describes field colors.

e Blue — An input field that accepts user entries. With very few exceptions, all
information should be entered in blue fields.

e Light Yellow — The currently active data entry field. You can change this to
a different color by accessing the preference for Input Fields.

e Green — A field that contains links or calculations referred to by the program.
The program displays a warning message whenever you attempt to enter
information directly in a green field.

e Pink — A calculated field that you've overwritten. To restore the original links
and calculations of a pink field, select the field, and then click the Restore
toolbar button.

e Purple — Indicates that the field has been marked as an estimate.

Overriding calculated fields

Calculated fields contain links or formulas that the program references. You can enter
data or formulas in a calculated field by overriding the current link or formula.
Calculated fields, which normally display with a green background, display with a pink
background when overwritten. To remove an override and restore program
calculations for a field, use the Restore command on the Client View toolbar.
IntelliForms tracks overwritten fields and information is reported when you use the
Check Forms feature. See: Checking Forms, below.

To override a calculated field

1. Select a calculated field.

2. Begin entering a value or other data.

1. The Calculated Field message box cautions you that you are overwriting the
contents of the field.

2. Click Override to continue.

3. Press Enter when you are finished entering the data.

Restoring overwritten fields
The Restore command restores the original contents of an overwritten field.

To restore a field to its original content

1. Select the field to be restored; the background color of the field is pink to indicate
that it is an overwritten field.

2. Click the Restore button on the Client View toolbar.

3. The original link or calculation is restored, and the background color changes to
green, indicating a calculated field.
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Marking a field as an Estimate

You can mark the amount reported in a field as estimated, leaving a trail for you to
come back and finalize the estimated amount.

To mark a field as estimated

1. Select the field to be marked.

2. Right-click and select Mark as Estimate.

3. The background color of the active field is now purple; to indicate that the amount
reported there has been marked as an estimate.

To restore the field to its normal state, do one of the following:

1. Select the field to be cleared; click Restore on the toolbar; or

2. Right-click in the field and select Mark as Estimate, again, to toggle off the
estimate notation.

To quickly locate all fields marked estimated, click Check Forms on the toolbar. The
Check Forms Report details all fields marked as estimates (as well as any notes
made to the form and all overwritten fields). See: Checking Forms, below.

Using the Right-click Menu

The Right-click menu in the Client View manager provides you with additional
options with respect to the data entry fields on your client forms. You can use the
Right-click menu features in both calculated (green) and general data entry (blue)
fields. Use the Right-click menu to do any of the following:

e mark an entry as an Estimate;

e remove an ‘estimate’ notation;

e attach an Itemized List to a data entry field,;

e insert, edit, and remove a Note to a field,;

e Insert text on a form;

e use the Cut, Copy, and Paste functions;

e Restore the active field;

e Link to Page 1 of the active form;

e display Instructions to the active form;

e display the Form version number for the active form.

To access the Right-click menu

1. Click in any data entry field and Right-click your mouse.
2. The Right-click menu is displayed.

34



Adding Forms to a Saved Client

You can use the Add Forms function in the Client View to add forms to a saved
client’s form set. The functionality of the Add Forms dialog box mirrors that of the
Blank Forms manager.

To add forms to saved client using the Client View manager

1. Open the client.

2. On the toolbar, click Add Forms.

3. IntelliForms displays the Add Forms dialog box.

4. Use the Find box and the form filters to find the form(s) you need.

5. Select the form(s) you want to open from the forms listed in the search results
grid.

6. Do one of the following:

* Click your form selection again (that is, double-click).
» Click Open Forms on the toolbar.

* On the Forms menu, click Open Selected Forms.

* Press Ctl+0O.

Working with the Client Form Set

Checking Forms

The Check Forms feature checks a client's form for certain field entry notations you
have made while you were working on the form. Specifically, the Check Forms
feature reports any fields with respect to which you:

e Marked the amount reported therein as an estimate
e Overwrote the amount of a calculated field; or
e Attached a note.

To use the Check Forms feature

1. On the toolbar, click Check Forms.

2. When the Check Forms window opens at the bottom of the screen, click the
reported estimate, override, or note to navigate to the field that triggered it.

3. Select a filter at the top of the Check Forms window to choose the type of
diagnostics to show in the list.

4. Temporarily hide specific diagnostics from view by checking the boxes next to

those items, and then clicking Hide Marked. Click Show All Items to display

diagnostics you previously hid.

Examine the field generating the reported item and make any necessary changes.

Click Recheck after you have made the appropriate changes.

If desired, click Print to print the Check Forms Report.

No o

35



Password Protecting Client Forms

Passwords prevent unauthorized users from accessing your client's forms and
sensitive data.

IntelliForms prompts you to select an optional password the first time you save forms
for a new client. See: Saving Client Forms, below.

You may also add or change a password any time the client's form set is open in the
Client View manager.

Caution: When a client's forms are open, any user with access to the open
forms may change or remove the password.

To add or change client passwords

1. Open the client.
2. On the Edit menu, click Client Password.
3. Enter a new password and click OK.
Note: Passwords are case-sensitive.
4. If you leave this box blank, clicking OK removes the client's password protection.
5. Verify the password by re-entering it, and then click OK.

Form Alerts

The Form Alert button in the upper right corner of the Client View screen is enabled
anytime the active form is subject specific filing requirements imposed by the federal
agency or state jurisdiction with which the form is filed. Click the Form Alert button
to review the specific filing requirements.

Saving Client Forms
To prevent loss of data, save your work frequently.

To save open client forms

Do one of the following:
* Press Ctrl+S.
* On the Clients menu, click Save Client.
* On the toolbar, click the Save icon.

Saving forms for a new client

The first time you save a form for a new client, the Client Name window appears,
prompting you to enter the following information:
» The name of the client;
* A client number (optional);
» A case-sensitive password (optional). The text you enter in this field is hidden. If
you enter a password, make a note of it and store it in a safe place.
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Saving Client Forms as PDF Files
IntelliForms allows you to save any part of a client’s form set as a pdf file, including
all forms, worksheets, statements, and reports.

To save client forms as a pdf file

1. With the client open in the Client View manager; click the Print Client button.

2. IntelliForms displays the Print Manager.

3. Initially, the print list includes, in the pdf file, all Forms, Worksheets, and
Statements.

4. Use the filters (on the left) and the specific document check boxes (on the right) to
limit the documents you want to include in the pdf file.

5. Click the Preview button to view a filtered list of the contents of your pdf file, if
desired. Click Close to return to the Print manager.

6. Click the PDF button on the Print Manager toolbar.

7. IntelliForms displays the Save as PDF file dialog box and automatically uses the
client’'s name as both the folder name in the Save in box and as the file name for
the pdf.

8. You can modify these names to better describe the specific contents of your
client’s pdf file.

9. Click Save and IntelliForms returns you to the Print manager.

10.Click Close to return to the active client.

Tip! Use descriptive names for pdf files.

Using descriptive names is especially helpful if you intend to save separate
forms as distinct pdf files for any particular client. For example, if you save both
John Doe's 1040 and his Maryland income tax return as separate pdf files,
giving the files distinct names, such as "JohnDoe1040.pdf" and
"JohnDoeMD502.pdf," can make accessing these files in the future easier.

Updating Saved Client Forms

With IntelliForms, there is no reason to worry about updating any form — even the
forms that you have previously saved for a client are automatically updated by
IntelliForms.

Every time you open an incomplete client in the Client View, IntelliForms
automatically updates the forms in the client’s form set and transfers the client’s data
to the most recent versions of the forms.

This means that you can use a draft version of any form and know that the data will
be automatically transferred to the final version of the form - the first time you open
that client following the form's release as final.

Caution: IntelliForms does not update forms saved for clients that have been
marked as Complete in the Client Forms manager.
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lll. PRINTING

IntelliForms offers you several printing options. Among these choices are the
following.

From the Blank Forms manager, you can print:

e a blank form;
e several blank forms at one time; or

e a list of blank forms you have selected.

From the Client Forms manager, you can print:

e a complete list of your clients;
e a list of clients marked complete; or

e a list of clients you have created based on your own criteria.

From the Client View manager, you can print:

e You can choose to print a client’s entire form set;

e You can print just the Current Form (active form) or schedule for the open
client in the Client View manager; or

e You can print just the Current Page (active page) of the active form.
e You can print any part or all of the Check Forms Report.

A. Printing Blank Forms
Under the Blank Forms tab, you can print Blank Forms without first opening the
forms.

To print a blank form without first opening

1

2.
3.
4.

Click the Blank Forms tab

Use the Find box and form filters to locate the form(s) you want to print.
Once found, click to select the form(s) to be printed.

Continue to do searches and make multiple form selections to print (or open)
altogether.

Caution: Once you have selected a form, you can continue to clear your form
filters and search for additional forms — so long as you do not change the year.
IntelliForms clears your form selections whenever you change the year.

To review your form selections before printing, check the Selected Forms box on
the filter pane, or choose Selected Forms from the View menu.
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6.

7.

Click Show All Forms to return the display to the full list of forms within your
subscription.
Choose Print Selected Forms from the Forms menu.

Tip! Printing Form Lists
You can choose Print Form List from the Forms menu to print a list of your
form selections, rather than the actual forms.

B. Printing Client Forms
Use the Print manager to print a client’s form set, or any part thereof. You can also
use the Print manager or to save any part (or all) of the client’s form set as a pdf file.

To print a client's form set

1.
2.

Open the Print manager by clicking Print Client on the toolbar.

The Print manager automatically includes the client's entire form set (that is, all
Forms, Worksheets, and Statements) in the print list. Use the check boxes on
the left to hide one or more of these categories from the print list.

Click the Expand toolbar button to display the remaining items on the print list. To
view a particular section of the Print List, click its + (plus sign). To collapse the
entire Print List, click Collapse. To collapse a particular section, click its - (minus
sign).

Use the individualized print check boxes in the print list on the right to further limit
the print job to include only the specific forms, worksheets, or statements you
want to print now.

Use the Override, Estimate Report, and Notes Report check boxes to include
these items in the print job.

To view a filtered list of the print job, click the Preview toolbar button. Click Close
Preview to return to the Print manager.

Enter the number of copies to print, if more than one.

Click the Print Client button on the Print manager toolbar to send to the printer.

Tip! Save forms as pdf files
Alternatively, you can click the PDF button to save the documents selected for
this print job as a pdf file.

If the focus stays on the Print manager after you send the job to the printer, click
Close to return to the active client's forms. See: Closing the Print Manager,
below.

Printing Specific Client Forms

You can print a specific form for any client the same way you print the client's entire
form set - by opening the Print manager and using the individualized print check
boxes in the Print List to limit the print job to include only the specific form,
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worksheet, or statement you want to print. You can also print a specific form for any
client without opening the Print manager.

To print a client form without opening the Print manager

1. Open the client.

2. Use the Form tabs (just above the active form) to navigate to the form you want
to print.

3. Do one of the following:
» Click the Print Form toolbar button; or
» Choose Print Current Form from the Client menu.

Printing the Current Page
You can print a specific page of any form, schedule, or worksheet.

To print a single page

1. Open aclient.

2. Use the Form Tabs (just above the active form) to navigate to the form with the
page you want to print.

3. Use the Pages & Worksheets tabs (at the bottom of the screen) to navigate to the
page you want to print.

4. Do one of the following:
* Right-click on the form, select Print Current Page.
 Click the Print Page toolbar button.
» From the Client menu, choose Print Current Page.

5. The page is immediately sent to your default printer without launching the Print
manager.

C. Printing Information Reporting Forms

The IRS and SSA machine-read paper forms. These forms must be printed with
paper and ink that meet IRS standards. If you plan to file paper forms with the IRS or
the SSA, read IRS Publications 1141, 1167, and 1179 for specific details about IRS
requirements for substitute forms, including print characteristics. The IRS updates
these publications as its standards change.

You can print recipient copies of these forms in IRS-approved formats. If you choose
to print the forms yourself, test a form for proper printer alignment. Use the Print
Alignment feature to align text on preprinted or approved substitute forms.

To align W-2 and 1099 data to print on substitute forms

Open a W-2 or 1099 form.

Click the Print Alignment button.
Select the appropriate paper type.
Adjust the margins and row spacing.
Click Print.

arwnE
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6. To revert to the default margin and row settings at any time, click Reset.

To test printer alignment for your forms, print on blank paper and then compare the
results to the substitute form to make sure the data is aligned properly.

D. Closing the Print manager

You can check the box under the Print manager tab of the Preferences window to
have the Print manager automatically close and return the focus to the active form
after each time you send a job to the printer. To view this preference, click the
Preferences toolbar button and select the Print manager tab.

E. Change Printer and Print Properties

1.

2.

3.

From the Print manager, click the Change Printer button in the upper right
corner.

In the Print Setup dialog box, review your printer settings and change them, if
necessary.

Click OK to save your printer settings.

Click the Close arrow to close the Print manager and return to your client’s
active form.
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V. GETTING HELP

A. Accessing Research

Commonly used federal forms are linked to supporting CCH research material that
explains the form or field in detail. These links are designed to take you to a highly-
relevant and compliance-oriented explanation with respect to both the form and
active field.

Each time you are working in a field that is supported by an explanation in the CCH
Tax Prep Partner series, IntelliForms enables the Access Research command on
both the Navigate menu and the Right-click menu. If the field is not linked to
supporting documentation, these commands are not enabled.

To access the CCH Tax Prep Partner explanation

5. Click in a linked field.

6. Do one of the following:
* Right-click and select Access Research.
* On the Navigate menu, click Access Research.

7. IntelliForms links you directly to the relevant Tax Prep Partner document in the
IntelliConnect database.

B. Help Modules

The following program resources (and more!) are available through the Support
menu of any manager and Support Explorer.

Support Explorer
Click the Help toolbar button from any manager and IntelliForms displays Support
Explorer, a browser-like help

oystemused by e program o (R 1 T I
organize and present a variety

of program resources. Lk Government Instructions *

Select an instruction setto display.

® Program Help

Program resources that can be
accessed using Support Explorer || * 5"

m

include the Program Help, = Instructions
Instructions, and Frequently W FAGs
Asked Questions (FAQs). ® QuickTutors

= Contact Us
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Program Help

Program Help contains instructions for program features and menu commands. The
contents of the Help window depend on the conditions under which it was opened.
You can display the Program Help from any manager by choosing Program Help
from the Support menu.

To browse Program Help, click the Contents button on the title bar of Support
Explorer window. Click any book button or subject title to open the topics list for the
subject, then select the subject you want to review.

QuickTutors

QuickTutors are short, easy-to-follow demonstrations of specific program features
and functions. After you click QuickTutors from Support Explorer, click the name
of a category, and then choose a QuickTutor to view.

Snppnrt Explorer I I I .
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= QuickTutors | Working with Profiles

= Contact Us M Importing and Exporting

* PDF Files

QuickStart Tour
The QuickStart Tour is a self-paced introduction to the program’s features.

To take the QuickStart Tour

From the Support menu of any manager,

Click QuickStart Tour.

The QuickStart Tour begins automatically.

Use the controls at the upper right to pause, skip ahead, or go back.

To navigate to the Tour’'s menu, click Main Menu.

To exit, close your Web browser by clicking the close (X) button at the top right
corner of the window.
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C. Online Support

To find Customer Support information, do one of the following:
e Click the Websites command on the Support menu of any manager;
e Select Support from the Support Explorer window; or

e Choose Contact Us from the Support menu of any manager.

D. Product Information
Click About on the Support menu of any manager to find the program’s release
number, and version, update, and license information.
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